

FREQUENTLY ASKED

QUESTIONS

The font-embedding feature of Microsoft Word isn’t
working.

This feature is only supported in Windows versions of Microsoft Word, and requires using the OpenType TT fonts.

installation

The OpenType layout features don’t work in Word 2010 for
Windows or Word 2011 for the Mac.

Should I use the OpenType (.otf ) or OpenType TT (.ttf )
fonts?

If the title bar of your document window says “Compatibility Mode,” Word has disabled OpenType layout features for
the current document. To fix this on Windows, go to File →
Info → Convert. On the Mac, save a copy in .docx format.

Both formats are compatible with Windows and Mac OS.
However, if you primarily use Microsoft Oﬃce on Windows
or WordPerfect, you should use the OpenType TT fonts.
Otherwise, use the standard OpenType fonts.
Can I have the OpenType and OpenType TT fonts installed
simultaneously?

The OpenType layout features don’t work in Pages 5.

Apple removed support for OpenType layout features in
Pages 5.0. But support has been restored in version 5.6 (released October 2015). So update to that version.

No. Use one format or the other.
How do I install or remove the fonts in Windows?

Right-click the fonts and select Install. Or from the Start
menu, open Control Panel → Appearance and Personalization > Fonts and drag the fonts into this folder. To remove fonts,
delete them from this folder. I’ve found that it’s wise to
restart after installing fonts, and before deleting. For more
detailed installation and removal instructions, see http://
typo.la/wininstall and http://typo.la/winremove.
How do I install or remove the fonts on Mac OS?

From the main directory of your system drive, open the
folder Library, then the folder Fonts. Drag the fonts into this
folder. (To remove fonts, delete them from this folder.) You
can also use Applications → Font Book to install and remove
fonts. For more detailed installation and removal instructions, see http://typo.la/macinstall.
How should I upgrade to new versions of the fonts?

Following the instructions above, remove the old versions,
and then install the new ones. On Windows, it’s wise to
restart before removing the old versions, and restart again
after installing the new ones.
I installed the standard OpenType fonts, but they don’t
appear correctly in PDFs made with the PDF generator built
into WordPerfect or Word for Windows.

This is a known limitation of WordPerfect and Word (see
http://typo.la/wordpdf ). Switching to the OpenType TT
fonts will cure the problem. So will switching to other software to make your PDFs (such as the Adobe PDF printer
driver, which is included with Adobe Acrobat). In this typographer’s opinion, the Adobe PDF printer is a wise investment, as it makes the most reliable PDFs, and can be used
with all your programs.

languages
What languages do the fonts support?

Afrikaans, Albanian, Basque, Catalan, the Celtic languages
(Welsh, Cornish, Breton, Irish, Scottish Gaelic, Manx),
Croatian, Czech, Danish, Dutch, English, Estonian, Finnish,
French, Galician, German, Hungarian, Icelandic, Indonesian, Irish, Italian, Latvian, Lithuanian, Malay, Maltese,
Norwegian, Polish, Portuguese, Romanian, Slovak, Slovenian, Spanish, Swahili, Swedish, Tagalog, and Turkish.
(Exception: Hermes Classic supports only Danish, Dutch,
English, Finnish, French, German, Icelandic, Italian, Norwegian, Portuguese, Swedish, and Spanish.)

license
Can I use the fonts in an e-book or app?

If your e-book or app format supports read-only embedding
of fonts, yes—an additional license isn’t needed.
Can I use the fonts on my website?

Sure, subject to the limitations in the license.
Where are the webfonts?

You make them yourself. See the last page of this FAQ for
my quick webfont-making tutorial.
I bought a multiple-person license. Where is it?

The terms are the same as the one-person license. You are
deemed to have a set of one-person licenses to hand out
within your organization.
Can I upgrade my license to cover more people?

Yes, by paying the diﬀerence in price between licenses.
Email me (mb@mbtype.com) and I will send you an upgrade
link for your situation.
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equity

typographic features

How do I use Equity in my documents?

How do I get small caps?

Once installed, Equity will show up in your Font menu under four separate names: Equity Text A, Equity Text B, Equity
Caps A, and Equity Caps B. If you install the Tab versions,
you’ll also see Equity Text A Tab, Equity Text B Tab, Equity
Caps A Tab, and Equity Caps B Tab.

Change your font to Equity Caps and use the lowercase
characters.

What’s the diﬀerence between Equity Text and
Equity Caps?

Equity Text is for body text. Equity Caps has the same uppercase characters as Equity Text, but it has small caps in
the lowercase positions. Equity Caps also has wider default
spacing than Equity Text.
What are the Tab fonts, and should I use them?

The Tab fonts are identical to the standard fonts, but they
have their tabular figures in the default positions, rather than
proportionally spaced figures. They’re provided primarily
for compatibility with programs like Microsoft Excel that
need tabular figures but don’t support the OpenType features. But you can use them in any program. You can also
have them installed alongside the standard fonts—they
won’t conflict with each other.
What’s the diﬀerence between the A and B fonts?

Only the weight: the B fonts are slightly lighter than the A
fonts, to account for oﬃce printers that tend to produce
darker text. I recommend printing some test documents in
both A and B to see which works best on your printer.
Can I have the A and B fonts installed simultaneously?

Yes. They show up in your Font menu separately.
Do I have to keep both the A and B fonts installed if I only
use one set?

No. They work independently of each other. If you want,
you can remove the set you’re not using.
Can I mix the A and B fonts?

To avoid inconsistencies, I don’t recommend mixing A and
B fonts in the same document. But you might find that A
works better in some documents, B in others. If you use Equity at large sizes, try the B weight.

What about that box in my layout program for small-cap
formatting? Should I turn it on?

Please don’t! This box does not trigger the Equity small
caps. Rather, it creates synthetic small caps by scaling down
the uppercase characters. This doesn’t look nearly as good
as Equity’s genuine small caps.
Can I add letterspacing to Equity Caps?

Sure. It’s not mandatory—consistent with my letterspacing
recommendations, Equity Caps has about 8% more letterspacing than Equity Text. But if you want to, go ahead.
If I’m setting all caps, should I use Equity Text or
Equity Caps?

You can use either. The uppercase letters look the same, but
they have more letterspacing in Equity Caps, which can be
convenient.
Should I use ligatures?

Use Equity’s ligatures if your typesetting program supports
automatic ligature substitution (this includes all professional
page-layout programs, as well as Word 2010 on Windows,
Word 2011 on the Mac, and Pages ’09 on the Mac).
What ligatures are in Equity Text?

The roman styles have ligatures for ﬀ, fi, fj, fl, ﬃ, and ﬄ:

oﬀ fin fjord floe aﬃne piﬄe
The italic styles have these ligatures, plus gg, gy, and ggy:

oﬀ fin fjord floe aﬃne piﬄe
egged gyro foggy
Are there any groovy stylistic alternates in Equity?

The italic fonts have a set of alternate forms that are available through OpenType stylistic set 3 (‘ss03’).

Jfhkvwy→Jfhkvwy
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Does Equity have fractions?

Gee, Equity has a lot of figures. Are there others?

Yes, it has all the standard single-digit fractions. All these
fractions are accessible in programs that support the OpenType fractions (‘frac’) feature. Microsoft Word does not—
so use the Insert → Symbol option to put the ⅐ ⅑ ⅓ ⅔ ⅕ ⅖ ⅗
⅘ ⅙ ⅚ ⅛ ⅜ ⅝ ⅞ fractions in your document. (For boring
technical reasons, Word does not make the others available.)
Pages ’09 allegedly supports OpenType fractions, but I’ve
never gotten it to work. Instead, use Edit → Special Characters → Symbols → Numbers and Number Symbols to insert
them.

Yes. Equity also has tall figures that align with the caps.
They can be accessed through the OpenType feature for
capital forms (‘case’), or stylistic set 2 (‘ss02’).

Does Equity have tabular figures?

The default figures in Equity are proportional lining figures
(proportional = diﬀerent widths; lining = same heights). Tabular figures—i.e., figures that are the same width—are available as an OpenType feature. Word 2010 for Windows,
Word 2011 for Mac, and Pages ’09 for Mac can all use the
OpenType tabular figures. If you need tabular figures in a
program that doesn’t support OpenType tabular figures, like
Microsoft Excel, just use the Tab versions of the fonts.

Regular figures
Tall figures

H0H1H2H3H4H5H6H7H8H9H
H0H1H2H3H4H5H6H7H8H9H

The Equity Caps fonts also have small-cap figures that align
with the small caps. They can be accessed through the
OpenType feature for caps-to-small-caps (‘c2sc’) or stylistic
set 10 (‘ss10’).
Regular figures
Small-cap figures

h0h1h2h3h4h5h6h7h8h9h
h0h1h2h3h4h5h6h7h8h9h

So that’s it for typographic features?

If you find the default quotation marks too large, you can get
smaller ones using OpenType stylistic set 1 (‘ss01’).
Default quotes
Small quotes

“So he didn’t say ‘uncle’ after all?”
“So he didn’t say ‘uncle’ after all?”

Does Equity have oldstyle (non-lining) figures?

Where can I see these typographic features in use?

Yes. They’re available as an OpenType layout feature.

In the Equity PDF specimen and throughout Butterick’s
Practical Typography.
Do you have any other document-formatting advice?

Of course.
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concourse

Can I add letterspacing to the C series?

How do I use Concourse in my documents?

Sure. It’s not mandatory—consistent with my letterspacing
recommendations, the C series has about 8% more letterspacing than the T series. But if you want to, go ahead.

Once installed, Concourse will show up in your Font menu
under 12 separate names: Concourse T2, T3, T4, T6, T7, T8
and Concourse C2, C3, C4, C6, C7, C8. Each number corresponds to one of six weights. If you install the Tab versions,
you’ll also see Concourse T2 Tab, T3 Tab, etc.
What are the Tab fonts, and should I use them?

[Answer on page 2 of the FAQ.]
What’s the diﬀerence between the T series and
the C series?

The Concourse T series is for body text. The C series is for
caps typesetting—it has the same uppercase characters as
the T series, but with small caps in the lowercase positions.
The C series also has wider spacing than the T series.
Why do some styles of Concourse have bold versions, but
not all?

If I’m setting all caps, should I use Concourse C or
Concourse T?

You can use either. The uppercase letters look the same, but
they have more letterspacing in the C series, which can be
convenient.
What ligatures are in Concourse?

Concourse has no ligatures. It doesn’t need them, because
the characters are designed not to collide (which is the problem that ligatures exist to solve).
Does Concourse have fractions?

Yes, a complete set of single-digit fractions. If your layout
program supports OpenType numerators and denominators,
you can also set your own arbitrary fractions.

Concourse weights 2, 3, and 4 use a copy of weight 6 as their
bold style. That way, if you’re using Concourse as a text
font, you can apply bold formatting in your document-layout
program and you’ll get the right result. Weights 6, 7, and 8
are already bold, so they can’t be further emboldened.

Does Concourse have oldstyle (non-lining) figures?

So what’s the diﬀerence between using the regular style of
Concourse T6 and, say, the bold style of Concourse T3?

Yes, Concourse has tabular versions of both the standard
and oldstyle figures.

Nothing. They’re the same. Use whichever method suits
your workflow and document-formatting habits.
Equity has weight grades. Why doesn’t Concourse?

Concourse weights 3 and 4 are close enough to act as grades
for each other, if you need fine weight control. Beyond that,
it was a command decision—given the typical uses of a sans
serif family, having a wider range of weights is more useful
than having grades.

typographic features
How do I get small caps?

Change your font to one of the Concourse C series fonts and
use the lowercase characters.
What about that box in my layout program for small-cap
formatting?

Don’t use it. It does not trigger the Concourse small caps.
Rather, it creates synthetic small caps by scaling down the
uppercase characters. This doesn’t look nearly as good.

Yes, it has a set of short figures designed to work alongside
lowercase or small caps. But unlike traditional oldstyle figures, there are no ascenders or descenders.
Does Concourse have tabular figures?

Why do the stylistic sets have names like “British Mode,”
“German Mode,” and so on?

Each of the stylistic sets, except one, is inspired by a sans
serif face associated with that area. The names are meant as
a nod to these models. Unfortunately, there’s no way to
make these names show up in layout programs, so you’ll
have to remember their boring OpenType names—
Eastern Mode
British Mode
French Mode
Swiss Mode
German Mode
Swedish Mode

=
=
=
=
=
=

Stylistic set 1
Stylistic set 2
Stylistic set 3
Stylistic set 4
Stylistic set 5
Stylistic set 6

Where can I see these typographic features in use?

In the Concourse PDF specimen, the Concourse web specimen, and throughout Butterick’s Practical Typography.
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triplicate

typographic features

How do I use Triplicate in my documents?

How do I get small caps?

Once installed, Triplicate will show up in your Font menu
under four separate names: Triplicate T3, Triplicate T4, Triplicate C3, and Triplicate C4 (with additional qualifiers if you
install one of the variant families described below).

Change your font to one of the Triplicate C series fonts and
use the lowercase characters.

What’s the diﬀerence between the T series and
the C series?

Don’t use it. It does not trigger the Triplicate small caps.
Rather, it creates synthetic small caps by scaling down the
uppercase characters. This doesn’t look nearly as good.

The T series is for body text. The C series is for caps typesetting—it has the same uppercase characters as the T series, but with small caps in the lowercase positions.
Should I use T3 or T4 for body text?

Whatever looks best. If you’re trying to match an existing
layout, T4 is closer in weight to the default Courier font on
Mac OS; T3 is closer to the Courier New font that’s included with Microsoft Oﬃce.
What are the Poly & Code fonts?

They’re just like the regular fonts, but with the Poly or Code
alternates in the default positions, so they can be used in
programs that don’t support OpenType layout features. In
your font menu, the Poly fonts have a “p” appended to the
family name; the Code fonts have a “c.”
What are the Short fonts?

They’re just like the regular fonts, but they have vertical
spacing that matches the standard Mac OS Courier font, for
use in programs that expect a font with those metrics. The
Short fonts have an “s” appended to the family name.
Can I have the Code, Poly, and Short fonts installed
simultaneously?

What about that box in my layout program for small-cap
formatting?

Can I add letterspacing to the C series?

Sure. It’s not mandatory, but if you want to, go ahead. Note
that if you add letterspacing, the font won’t be monospaced
anymore.
If I’m setting all caps, should I use Triplicate C or
Triplicate T?

You can use either. The uppercase letters are the same.
What ligatures are in Triplicate?

As a monospaced font, Triplicate needs no ligatures and
thus has none.
Does Triplicate have fractions?

Yes, a complete set of single-digit fractions. If your layout
program supports OpenType numerators and denominators,
you can also set your own arbitrary fractions.
Does Triplicate have oldstyle (non-lining) figures?

Yes. They’re available as an OpenType layout feature.
Are the Poly & Code alternates available as OpenType
features?

Yes. They will show up in your font menu under separate
family names.

Yes. The Poly alternates are available as Stylistic Set 1; the
Code alternates as Stylistic Set 2.

Why doesn’t Triplicate have Tab fonts, like Equity &
Concourse?

Does Triplicate have tabular figures?

The default figures in Triplicate are already the same width,
so there’s no need for Tab versions.

The default figures are already tabular, so there’s no separate
OpenType feature for tabular figures.
Where can I see these typographic features in use?

In the Triplicate PDF specimen and throughout Butterick’s
Practical Typography.
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advocate
How do I use Advocate in my documents?

Once installed, Advocate will show up in your Font menu
under 18 separate names: Advocate C41, Advocate C51, Advocate C61, Advocate C43, Advocate C53, Advocate C63, Advocate
C45, Advocate C55, Advocate C65 (the nine sans serif styles)
and then the Advocate Slab ... versions with the same numbers. (You’ll see more names if you install one of the variant
families described below.)

Can I have the regular, Tab, and Mid fonts installed
simultaneously?

Yes. They’ll show up in your font menu under separate family names. (Also fine to omit the ones you don’t need.)

typographic features
How do I get small caps?

Switch to lowercase.

That’s a ton of fonts. Do I have to install them all?

What about that box in my layout program for small-cap
formatting?

No. You can just install the ones you need (or install them
all, and delete the ones you don’t need).

Don’t use it. It doesn’t trigger the Advocate small caps. Just
switch to lowercase.

Your other fonts have a T series and C series, but Advocate
only has a C series?

Can I add letterspacing to Advocate?

Right. It’s strictly a caps font. Regular caps in the uppercase
slots; small caps in the lowercase slots.
What do the style numbers mean?

The first digit indicates the weight (4, 5, or 6, corresponding
to regular, medium, and bold) and the second digit indicates
the width (1, 3, or 5, corresponding to condensed, narrow,
and regular).
What’s the diﬀerence between Advocate and Advocate
Slab?

Just the presence of slab serifs on certain characters. The
other characters are identical between the two styles.
How do I choose which style to use for my project?

Use whatever you like best. Experiment. Have fun! The
styles are designed to harmonize with each other. You can
mix weights, width, and cases:

you’re NEVER doing it WRONG!
What are the Mid fonts?

They’re the same as regular fonts, but with the small caps
elevated to the vertical midline:

Regular Small Caps (on the Baseline)
Mid Caps (Lifted above the Baseline)
In your font menu, the Mid fonts have the word “Mid” appended to the style.
What are the Tab fonts, and should I use them?

[Answer on page 2 of the FAQ.]

Sure. It’s not mandatory—the fonts are already letterspaced—but if you want to, go ahead.
What ligatures are in Advocate?

As a caps font, Advocate needs no ligatures and thus has
none.
Does Advocate have fractions?

Yes, a complete set of single-digit fractions (available
through the OpenType ‘frac’ feature). If your layout program supports OpenType numerators and denominators,
you can also set your own arbitrary fractions.
Does Advocate have oldstyle (non-lining) figures?

No. Those are designed to work with ordinary lowercase
letters (not small caps), so there’s no call for them here.
Are the Tab & Mid alternates available as OpenType
features?

Yes. The Tab figure alternates are available through the usual OpenType tabular-figures feature (‘tnum’). The Mid alternates are available as Stylistic Set 11.
Any other OpenType features?

Advocate supports the cap-to-small-cap feature (‘c2sc’)
which is duplicated in Stylistic Set 10. This feature is the
only way to access the small-cap figures and punctuation—
the default figures and punctuation are sized to fit the normal caps.
Advocate has alternates for the R, K, and ampersand in
Stylistic Set 01:

R&K rk → R&K rk
In the condensed and narrow widths, Advocate also has optical alternates in Stylistic Set 02, to help certain letters look
better at small sizes (e.g., business cards).
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hermes classic
How do I use Hermes Classic in my documents?

Once installed, Hermes Classic will show up in your Font
menu under six separate names: Hermes Classic T2, Hermes
Classic T3, Hermes Classic T4, Hermes Classic T6, Hermes
Classic T7, and Hermes Classic T8. (You’ll see more names if
you install the Tab styles described below.)
What makes this font “Classic”?

I designed the Hermes family in 1993. Until 2017, I oﬀered it
through another font vendor. I plan to release a revised version of Hermes in 2017. But I also want to keep the previous
version available for those who have already been using it &
whose documents depend on it. Hence “Classic”.
So it’s the same as the previous version?

In the important ways: the character set, glyph design, and
horizontal metrics are the same as before. But I’ve changed
the style names to be consistent with other MB Type fonts,
and adjusted some small technical details. So, if I haven’t
goofed things up, you can use it wherever you used Hermes
before, without any text reflow.
Your other fonts have a T series and C series, but Hermes
Classic only has a T series?

Have you expanded the character set to be consistent with
your other fonts?

No. It has the same character set as before. I will not be expanding it. It is a perfect ’90s time capsule.
What are the Tab fonts, and should I use them?

The Tab fonts are identical to the standard fonts, but they
have their tabular figures in the default positions, rather than
proportionally spaced figures. They’re provided primarily
for compatibility with programs like Microsoft Excel that
need tabular figures but don’t support the OpenType features. But you can use them in any program.
Can I have the regular and Tab fonts installed
simultaneously?

Yes. They won’t conflict with each other. The Tab family
names are Hermes Classic T2 Tab, etc.

typographic features
What ligatures are in Hermes Classic?

Just the fi and fl.
Does Hermes Classic have fractions?

No.

Right. It’s strictly a text font in six weights, with italic styles.
There are no small-cap styles.

Does Hermes Classic have oldstyle (non-lining) figures?

How do the old style names correspond to the new ones?

Are the Tab alternates available as OpenType features?

Hermes Thin
Hermes Book
Hermes Regular
Hermes Semibold
Hermes Bold
Hermes Black

Yes. The Tab figure alternates are available through the usual OpenType tabular-figures feature (‘tnum’).

=
=
=
=
=
=

Hermes Classic T2
Hermes Classic T3
Hermes Classic T4
Hermes Classic T6
Hermes Classic T7
Hermes Classic T8

Why do some weights of Hermes Classic have bold styles,
but not all?

Hermes Classic weights T2 and T3 use a copy of weight T6
as their bold style; weight T4 uses a copy of weight T7. That
way, if you’re using Hermes Classic as a text font, you can
apply bold formatting in your document-layout program and
you’ll get the right result. Weights 6, 7, and 8 are already
bold, so they can’t be further emboldened.

No.

Any other OpenType features?

There are a few alternates in Stylistic Set 01:

M&QW agw → M&QW agw
For backward compatibility, there are also some unicase alternates in the ‘unic’ feature. I loathe these. But I can’t take
them out now. File under “seemed like a good idea at the
time”.

So what’s the diﬀerence between using the regular style of
Hermes Classic T6 and, say, the bold style of Hermes
Classic T3?

Nothing. They’re the same. Use whichever method suits
your workflow and document-formatting habits.
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how to make webfonts
Though my font license permits webfont usage, I don’t ship the actual webfonts. Why? Because most designers
and developers prefer to customize their
webfonts—for instance, to omit unused
characters and make the files smaller.
You can use any webfont converter you
like. But I use the Font Squirrel webfont
generator (see http://typo.la/squirrel).
(This tool is supported by voluntary
payments, so if you like it, please consider donating using the link at the bottom of its page.)
To start, select the “Expert” button at
the top, which will reveal the other options.
The most important setting on this
page is the “Em Square Value.” (It’s
the one I’ve marked with a red box.) By
default, Font Squirrel will use 2048.
Before you do anything else, change
this to 1000 to match the existing emsquare value of the fonts. Without this
change, screen quality of the webfonts
will suﬀer, especially on Windows.
Click the “Add Fonts” button and select the fonts you want to convert. I
recommend using the OpenType TT
fonts, because they’re already hinted for
better screen display on Windows.
Thus, you should also go to “TrueType
Hinting” and select “Keep Existing.”
For “Font Formats,” nearly all modern
browsers support the woff format.
Unless you know you need other formats, just stick with that.
The “Subsetting” option will open a panel showing you
glyphs that you can include or omit. This will produce
smaller font files (though for most websites, this is a needless
optimization).

You can’t break anything using the Font Squirrel generator,
and you can make as many webfont kits as you like. Don’t be
afraid to experiment with diﬀerent settings.

Finally, click the “Agreement”—because yes, as a licensed
user, you can legally convert these fonts—and then click
“Download Your Kit.” You’ll receive a zip file containing
the webfonts, plus a type-specimen web page. This page
gives you an easy way to check that the fonts came out the
way you wanted them to.
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